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CHAPTER  1 

1 OpenOffice.org

1.1 Highlights

1.1.1 System integration

� In the interest of having OpenOffice.org become a well integrated citizen on all sup-
ported Oss, the integrated desktop has been removed.
Furthermore,the Beamer, Explorer, E-Mail client, News client and Scheduler have also
been removed.
OpenOffice.org word processing/WEB cannot create frame sets anymore.
All OpenOffice.org documents will be able to be sent as e-mail right from the “File –
Send” menu.

� New Address Book handling:
New dialog under File/Templates/Address Book Source will offer a user interface for Ad-
dress Book field assignment. Thus the old StarOffice address books as well as internal
system address books will be able to be seamlessly integrated into OpenOffice.org.

� File Dialog has changed:
File navigation has been simplified.  Menus and window frame buttons now appear in
the same order found in other industry standard interfaces.

1.1.2 XML File Format

XML has been adopted as the new native file format, replacing the old binary file format.
The new XML based format provides an open standard for office documents and represents
a complete specification encompassing all OpenOffice.org documents.

The XML filters of the different OpenOffice.org modules store packages instead of plain
XML files. A package is simply a compressed file (zip, tar). The plain XML file is contained
within the "Content" entry of the package.

To reflect the new XML format, the file name extensions have been changed:

word processing sxw

word processing Master Document sxg

spreadsheets sxc

draw sxd

presentations (packed) sxi (sxp)

math sxm (fully compliant with mml standards)

Documents created in StarOffice 5.2 or earlier versions will continue to be supported. They
will be able to be loaded and saved either in the new XML based format or in the old bi-
nary format.
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1.1.3 New Document Converter

A new Document Converter is available that allows for conversion of both Microsoft and
binary StarOffice documents to the new XML format of OpenOffice.org. Therefore, the Im-
port Wizard has been completely revised. Furthermore, the user interface has been redes-
igned to reflect standard wizard format.  The Document Converter also incorporates an op-
tion to trace the conversion actions by writing to a log file. This log file will be written to
the openoffice60/user/work directory.

1.1.4 New WebDAV Support

With OpenOffice.org it will be possible to access resources using the WebDAV protocol, the
IETF standard for collaborative authoring on the Web. WebDAV (Web-based Distributed
Authoring and Versioning) is a set of extensions to the HTTP protocol which facilitate col-
laborative editing and file management between users located remotely on the Internet.
This enables users to collaborate over the Web in the same way as they might over a corpo-
rate intranet.

1.1.5 New Unicode Support

OpenOffice.org will support the Unicode Character standard which covers the principal
written languages of the world. Thus, the creation of documents containing characters
from different scripts, e.g. Western and Cyrillic, is no longer problematic. In earlier ver-
sions, only the character set of the system could be used.

The dialog for inserting special characters will handle the complete Unicode character set
and will be extended to show some information about Unicode's sub-ranges.

1.1.6 New Features for Asian Languages

To support Japanese, Chinese traditional, Chinese simplified and Korean text input, the fol-
lowing changes were made:

1.1.6.a Vertical writing within Text Boxes and Callouts

1.1.6.b New Character Attributes

� Ability to define different text fonts for Western and Asian languages including sepa-
rate language settings. This will allow the user to define specific fonts for each language
region according to the font's attributes.

� New font effect “Emphasis Mark” with four different markups and text positioning. The
Emphasis Mark is a very common way for Asian layout to stress text.

� Asian Layout tab page with “Double Line in one line” text formatting including free
choice for enclosing characters (e.g. brackets). Very common for inserting prolonged
Latin based text within Asian character based documents.

1.1.6.c New Text Properties for Asian Layout

A new sub menu has been added to the Format menu for assigning the text cases Upper,
Lower, Full Width, Half Width. Further case options refer to the Japanese languages Hira-
gana and Katagana.

1.1.6.d Ruby Text

Ruby text (explanatory text above the original text) will be able to be inserted. Ruby text is
needed in most East Asian languages to add more information to written text, e.g. if a very
rare Japanese word is written, Ruby is used for explanation and/or correct pronunciation.
The Ruby Text window is designed as a floating window so that the user does not have to
close the window to apply changes made to the text. It also works with multiple selected
text and has an automatic detection feature to help the user find the right Ruby expres-
sion more easily.

10



1.1.6.e Vertical Character Position

Text will be able to be rotated by 90 or 270 degrees to specify the writing direction from
bottom to top or from top to bottom. The new options will be found under Format - Char-
acter - Position - Rotation/Scaling. The rotated text will be able to be scaled to a percentage
of its original value or to fit the height of the current line.

1.1.6.f Vertical Text Alignment

Once characters are rotated by a number of degrees (see 1.1.6.e) the paragraph will be able
to be formatted to  “Automatic”, “Baseline”, “Middle”, “Bottom” or “Top”. Thus the vertical
text will be able to be aligned similarly to the ways horizontal text is aligned (“Centered”,
“Left”,”Right”, etc.).

1.1.6.g Combine Characters

A new field type will be available that will allow for the definition of up to 6 characters
that are handled as 1 normal character. This function will be found under Insert - Fields -
Other - Functions and will be called Combine Character.

1.1.6.h International Numbering Styles

For CJK new numbering styles will be introduced. 

1.1.6.i New Find & Replace features for Asian languages “sounds like (Japanese)”.

This dialogue enables the user to differentiate in between different syllables, Katakana and
Hiragana while also ignoring special characters.

1.1.6.j New Pages under Tools - Options - Asian Typography

Default settings for all Asian documents will be able to be defined here for Japanese Find
and Asian Layout.

1.1.6.k Special Font Size Naming conventions

Chinese customarily use a larger font size measured in point special pre-defined named
sets. These will also be available within the font size dialog box once Chinese is the refer-
ring language.

1.1.6.l New Impress AutoLayouts for Vertical Text (CJK)

Four new AutoLayouts containing vertical text have been introduced to presentations.

1.1.7 New International Number Formats

The dialog for assigning number formats has been completely revised to support interna-
tional formats for date, time and currencies:

1.1.7.a New Languages

To specify a number format for a specific locale, the user will be able to choose between
more than 90 languages.

1.1.7.b New Date Formats

Three different calendars will be supported to specify the date in specific formats: In addi-
tion to the Gregorian calendar, the Japanese Gengou and the Korean ROC calendar will also
be able to be used. To support multiple calendars, new format code keywords for date and
date/time formats will be available.

1.1.7.c New Currency Formats

There may be different currencies defined for one locale. These will be offered automati-
cally when choosing a specific language in the dialog (previously these were defined manu-
ally).
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1.1.8 New Options Dialog

1.1.8.a New Page for Languages

� See New Page Options - General - Languages

1.1.8.b New Filter Options for OLE Objects

New filter options for the import and export of MS Office documents will be available un-
der Tools - Options - Filter Settings. Here the user will be able to specify whether MS Office
OLE objects (WinWord, Excel, PowerPoint, MathType) should be converted into
OpenOffice.org objects (word processing, spreadsheets, presentations, math) or vice versa.
This is especially useful in on those platforms that lack an MS OLE Server (or an OpenOf-
fice.org OLE Server respectively), such as UNIX.

1.1.8.c New Entry Locale Setting

The tab page has a new entry called "Locale setting" that contains the locale of the current
office installation. This locale determines language dependent settings like number format-
ting, currency and measurement units.

1.1.8.d Toggle Switch for CJK Support

The dialog “Tools – Options - Language Settings - Languages” will contain a check box to en-
able/disable support for Asian languages.

This setting controls the availability of the following dialogs and dialog elements:

� Format - Character - Asian layout

� Format - Character - Font - Asian text font 

� Format - Character - Font effects - Emphasis mark

� Format - Paragraph - Asian typography

� Format - Ruby

� Format - Change case – Half + Full width + Hiragana + Katagana

� Tools - Options - Language settings - Japanese find

� Edit - Search & Replace - Japanese find

� Tools - Options - Language settings - Asian typography

1.1.9 New Layout

All tab pages are undergoing a visual and contextual redesign. 

The group boxes in Tab pages will be replaced by more modern vertical separators.

Some controls and settings will be renamed and/or moved to more sensible locations to in-
crease ease of use.

1.1.10 New Gallery

The Gallery will be completely revised. It is accessible via the menu command under Tools
- Gallery or just by clicking on the Gallery icon in the function bar.

1.1.11 New Dialog For "New from Template"

The new dialog “New from Template” will be divided into three parts. 

The left pane will display an icon list with the subcategories “New Document”, “Template”, 
“My Documents” and “Samples."

By activating one of these entries, the file view in the middle pane will show the content of
the activated folder.
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Opening a file from within this pane will display a preview of the content of the file in the
right pane.

Double-clicking on the file or using the “Open” button will open the selected document
within the application.

1.1.12 Enhanced Euro Converter

The Euro converter will read and convert spreadsheets and word processing text docu-
ments.

1.2 New Filters for the Formula Editor

1.2.1 New MathType Filter

Formulas embedded in a document will be converted from and to MathType when import-
ing to or exporting from an MS Office file format.

1.2.2 New MathML Filter

A new import and export filter will be available for MathML files based on the the stan-
dardized W3 XML file format for equation exchange.

1.3 Other Noteworthy Enhancements

1.3.1 Form Controls

Radio buttons will have an additional event "When initiating" allowing the user to bind ac-
tions to the control on initiation. 

1.3.2 New Dialog Sizes

The size of standard dialogs will be increased. Tab pages will be resized and partially re-
structured. The former tab page size of 260 x 135 AppFont Units (1/8 of the height of the
font used inside dialogs) has increased to 260 x 185 AppFont Units.

1.3.3 Dialogs as System Windows

Dialogs will be handled as system windows. As a result they will be able to be moved out-
side of the task window.

1.3.4 Page Preview

Page preview for text documents and spreadsheets will be opened within the original docu-
ment window instead of in a new window. This function will be activated and deactivated
by using the menu command File - Page Preview.

1.3.5 Passwords as Encrypted Hash Values

Passwords for sections in text documents as well as all passwords in the spreadsheet appli-
cation will be stored in an encrypted hash value. These XML passwords will not export to
other (older) formats. However, when loading a document from an earlier version, the
password will be encrypted and will remain functional.

1.3.6 Charts

The insertion of stand-alone charts will no longer be supported. However, old files (*.sds)
will still be able to be loaded. It will also be possible to insert a stand-alone chart as an OLE
object.
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1.3.6.a Editing Chart Data

For changing chart data in a chart whose data comes from outside the container (such as a
spreadsheet), the Data dialog will be able to be called via the Chart Data menu item. This
item will be moved from the View menu to the Edit menu. Furthermore the dialog will be
accessible from all context menus.

1.3.7 Images

The features of the former Image module will be integrated into the different application
modules of OpenOffice.org. This transmission will have an effect on the user interface
namely in that the Image interfaces and libraries will not be available anymore.

When loading older office documents containing Image OLE objects, a graphic object will
be created instead of the OLE object. The graphic will be extracted based on the data in-
cluded in the corresponding Image OLE storage.

1.3.7.a Graphic Filters

The filter functionality of the former Image module will be available for graphics in text
documents, presentations and drawings. For this, the Filter tool for a selected graphic in
the Graphic object bar will be extended. New Option dialogs will be designed to adjust the
corresponding parameters for the selected effect. As an additional feature, a preview win-
dow will be available in every dialog. 

Tiling will not be available as a single filter anymore. Instead, a check box will be available
in the Options dialog which will allow the user to choose whether edges should be en-
hanced (old Mosaic functionality) or not (old Tiling functionality).

1.3.8 Version Info for DLLs under Windows

Version information will be available for the OpenOffice.org DLLs under Windows. They
will be displayed by the Version tab of the Properties dialog of a DLL.

1.3.9 Exchanged OpenOffice.org API

The new Application Programming Interface (API), that was introduced in StarOffice 5.2,
now wholly replaces the former programming interface. Note, that macros based on the
old interface will not be supported anymore.

1.3.10 Advanced Font Effects

The behavior of word-wise underlining/strikethrough (Format - Character - Font Effects)
will be improved. Previously, this function's effects were only seen on alphanumeric char-
acters (e.g. e-mail, 100,00 DM). Now every character will be affected by this, excepting
spaces (e.g. e-mail, 100,00 DM).

1.3.11 Advanced HTML Export

It will be possible to define the text encoding for the HTML export. Therefore a new list box
Character Set will be added to the HTML export options. This will enable the user to gener-
ate export files encoded with Unicode (UTF-8), for example.

1.3.12 New Configuration Files

Configuration data, formerly mainly stored in *.ini-files, will be saved as XML data. The
data has been restructured to store the configuration settings for different program pack-
ages or modules in appropriate XML files. The program will install the files under
share\config\registry while special user data will be stored under user\config\registry.

Other files containing the data for hatching (*.soh), dashes (*.sod), line ends (*.soe), color
palettes (*.soc), gradients (*.sog), and bitmaps (*.sob) will be stored in XML, too. However,
these files will maintain the old file extensions to support former versions. This is also true
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for AutoFormat data for tables (*.fmt), AutoText modules (*.bau) and AutoCorrect lists
(*.dat). Furthermore those files will now be Unicode compliant and will be able to store, for
example, Chinese or Japanese names.

1.3.13 New Handling of Printers and Fonts under UNIX

Under Solaris and Linux a completely new solution for printing and font rendering will be
introduced which will lay to rest the technical limitations of the old implementation. It
will enable the user to print and display every TrueType font and see a quality of text dis-
play on the screen which is comparable to Windows. For rendering the fonts FreeType will
be used.

The major advantages of the new solution will be:

� TrueType support

� Support of Chinese, Japanese and Korean languages

� Smaller and faster PostScript output

To make the PostScript output smaller and more effective, font substitution will be used. If
this feature is active, the advised fonts will be replaced by printer built-in fonts (providing
that these fonts contain the same characters). Where the built-in fonts lack the necessary
characters, OpenOffice.org will fallback on the original font from which the missing charac-
ters will be downloaded.

This feature will be accessible via a new page called Font Substitution in the configuration
dialog of the Administration tool "spadmin". When a new printer is added, font substitu-
tion will be enabled by default and the substitution table will already contain defaults to
map the fonts of OpenOffice.org.

1.3.14 Support of PDF Conversion under UNIX

A PDF conversion printer will be supported under the UNIX platforms. As with Windows, a
printer will be able to be configured to convert the PostScript output of an OpenOffice.org
document into a PDF document automatically. For this, the administration tool "spadmin"
will be used. If a new printer is added here, a Connect dialog will be opened in which the
user can configure the command line that should be executed to process the output. If
Ghostscript or Distiller is installed, pre-configured command lines will be available.

1.3.15 SPAdmin Updated

SPAdmin will undergo a major refit. The main dialogue will be simplified: 

The connect dialogue will become another tab page beneath "Properties..." The driver man-
agement will move so that a driver is actually selected and a new "Add printer..." button
will be added that will start a wizard for new printer creation.

1.3.16 Enhanced Font Handling (e.g. AntiAliasing) under Unix OS

To enhance the text display quality on Unix platforms the font handling will be com-
pletely reworked. New features will be:

� Fonts will be able to be displayed antialiased

� TrueType collection fonts (*.ttc) 

� Rotated text and Kerning will work

� Embedded bitmaps will work

� Vertical glyph substitution will work

� Text will be able to be stretched (e.g. in Draw)
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An essential requirement for the feature above will be font in Type 1 or TrueType format
and in a readable format for the office suite. Antialiasing will work on all 24 or 32bit true
color modi or on 8bit grayscale visuals. A render extension on the display will be sup-
ported but not required.

1.3.17 New Printing Solution under Unix OS

The printing output under Solaris and Linux will undergo amajor rework.

Highlights will be:

� Support of TrueType fonts and TTC-Fonts

� CJK capability (e.g. vertical text output)

� A PDF printer will be able to be installed if GhostScript or Adobe Distiller is available for
direct PDF generation.

� Printing directly to all available printer queues without installing specific printers

� Kerning will be supported

� Font substitution for standard PostScript fonts will available and configurable
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CHAPTER  2 

2 Text Documents

2.1 Highlights

2.1.1 New Features for the Support of Asian Languages

2.1.1.a Ruby Text

Ruby text (explanatory text above the original text) will be able to be inserted. Ruby text is
needed in most East Asian languages to add more information about written text, e.g. if a
very rare Japanese word is written, Ruby is used for further explanation and/or correct pro-
nunciation. The Ruby Text window will be designed as a floating window thus the user will
not have to close the window to apply changes made to the text. It will also work with
multiple selected text and will have an automatic detection feature to help users find the
right Ruby expression more easily.

2.1.1.b New Text Properties for Asian Layout

A new sub menu will be added to the Format menu for assigning the text cases Upper,
Lower, Full Width, and Half Width. Further case options will refer to the Japanese languages
Hiragana and Katagana.

2.1.1.c Combine Characters

A new field type will be available that will allow for the definition of up to 6 characters
that are handled as 1 normal character. This will be found under Insert - Fields - Other -
Functions and will be called Combine Character.

2.1.1.d Vertical Character Position

Text will be able to be rotated by 90 or 270 degrees to specify the writing direction from
bottom to top or from top to bottom. The new options will be found under Format - Char-
acter - Position - Rotation/Scaling. The rotated text will be scalable to a percentage of its
original value or to fit the height of the current line.

2.1.1.e Vertical Text Alignment

Once characters are rotated by a certain number of degrees (see 2.1.1.d) the paragraph will
be able to be formatted to  “Automatic”, “Baseline”, “Middle”, “Bottom” or “Top”. Thus verti-
cal text will be able to be aligned similarly to the ways horizontal text is aligned (“Centered
”,“Left”,”Right”, etc.)

2.1.1.f International Numbering Styles

For CJK new numbering styles will be introduced. 

2.1.1.g Advanced Encoded Textfilter 

The Encoded Textfilter will be upgraded and expanded to new Chinese, Korean and Japa-
nese character sets. Furthermore a new Unicode set will be included which will enable the
creation of Unicode text files containing 16 instead of 8 bit characters.
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For more features, see New Features for Asian Languages

2.1.2 New Graphic Features

For graphics inserted in a text document some new features will be offered that formerly
were only available in drawing and image mode. They will be reachable via the new Graph-
ics Object bar:

2.1.2.a Graphic Attributes

Graphic attributes, that are well-known from StarOffice Draw will also be available in
OpenOffice.org word processing. When a graphic is selected, the Object bar will offer set-
tings for the following attributes:

� graphics mode (default, grayscale, white/black and watermark)

� alpha channels for the colors red, green and blue

� brightness

� contrast

� gamma value

� transparency

� mirror (flip vertical, horizontal)

The functionality of the different attributes will be the same as in Draw.

The frame attributes such as adjustment, anchor changes, borders, etc. will be moved to
the Frame Object bar, which will be able to be reached with the little arrow button on the
right side. Here it will also possible to specify a background color for a graphic.  This will be
particularly useful for cropped graphics or where a border with some distance is applied.

2.1.2.b Graphic Filters

The Graphics Object bar will also contain a new icon for converting a bitmap. The different
filters offered here (Invert, Smooth, Sharpen, etc.) will be adapted from the former StarOf-
fice Image module and integrated into OpenOffice.org word processing.

2.2 Other Noteworthy Enhancements

2.2.1 Password Protection of Change Track Function

The status switch for the Change Track function will be able to be protected with a pass-
word. Thus change tracking on sensitive data/spreadsheets will be able to be locked to on.

2.2.2 New AutoFormat Options

To offer the possibility to apply styles or numberings via AutoCorrect without deleting ex-
isting tabs and blanks, two new options will be available under "Tools - AutoCorrect/Auto-
Format - Options". With these the user will be able to specify whether blanks and tabs
should be deleted at the beginning or at the end of a paragraph or a line, respectively.
These options will only take effect where a paragraph is changed by AutoCorrect while typ-
ing, e.g. if a style is applied automatically (check box Apply Styles active) or the automatic
numbering is active (check box Apply Numbering...).

2.2.3 Extended Line Numbering

The dialog for line numbering will have a new option to restart the numbering at each new
page.
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2.2.4 New Character Attribute “Font Autocolor”

Once this new feature is set, the font color will be adjusted to the default font color of the
operating system. Furthermore, changing the background to a dark color will automati-
cally change the font to white.

2.2.5 New Character Attribute “Relief“

The character attribute “Relief” with the sub-functions “Embossed” and “Engraved” will be
implemented. These features will also work with MS Word import and export.

2.2.6 New Underlining Color Setting

“Underlining” as well as “Strikethrough” will now be able to have independent color set-
tings. E.g. one will be able to have black text with red underlining.

This feature will also apply to OpenOffice.org's MS Word 97/2000 import and export filters.

2.2.7 Negative Indents for Paragraphs and Tables

It will be possible to set negative (left or right) indents to paragraphs and tables. For para-
graphs this will be achieveable via Format - Paragraph - Indents&Spacing or simply by us-
ing the ruler. In former versions the first line indent was only allowed to be negative when
there was a positive left indent with a greater value. (Thus it was not possible to align
headlines left from the page margin, for example.) This restriction will not exist anymore.
The first line indent will be able to be specified independently from the left indent of a
paragraph. This gives the user more freedom for the layout of a document.

For tables, it will also be possible to set an alignment from the left with negative spacing
values in the Table Format dialog. Thus table alignment will not be restricted to page mar-
gins.

2.2.8 Advanced Behavior of URL Attributes

When changing a hyperlink in a document (without AutoCorrect), the corresponding URL
attribute will adapt the new settings automatically, if it is a valid URL. If, for example, an e-
mail address or an http-link is changed in the document, the program will change the cor-
responding mailto-address or the URL target, as well. In former versions this had to be
changed manually.

2.2.9 Changed Cursor in Overwrite Mode

Overwrite mode will have a new cursor display. Thereby a selected character will be over-
written next.

2.2.10 Unrestricted Border Distances

The border distance of table cells and paragraphs (Format - Table/Paragraphs - Borders) will
be able to be set to zero. In former versions there was a minimal distance restriction.

2.2.11 Saving Custom Label Formats

The user will be able to define and save custom label formats. The current label settings
will be saved under "File - New - Label – Format". When saving a label format, it will be pos-
sible to define a new brand and/or label type.

2.2.12 Advanced Hyphenation Rules

Under Tools – Options – General - Writing Aids it will be possible to define the minimal
word length for hyphenation.
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2.2.13 Additional Settings on Paste Button

The Paste button within the function bar will include a contextual menu, activated by a
long single mouse click. 

This new menu will enable the user to choose between additional paste formats such as
Unformatted Text, Bitmap, etc. The dialog will contain the same selection that is available
through “Edit – Paste Special.”

2.2.14 Additional Settings on Undo and Redo Buttons

The Redo and Undo buttons within the function bar will include contextual menus, acti-
vated by a long single mouse click.

The new menus will enable the user to undo and redo the last action.  Additionally, users
will be able to choose from a list of undo and redo steps that are available.

2.2.15 Separate Passwords for Text Sections

Instead of offering one password for section protection, users will be able to select unique
passwords to protect individual sections.

This setting will reside in the “Insert – Section” and “Format – Section” dialogs.

2.2.16 Advanced MS Office Filter

2.2.16.a Form Controls

The MS filter will support form elements. The import and export filter for MS Office
97/2000 will support the conversion of MS Office controls to OpenOffice.org word process-
ing control shapes and vice versa.

2.2.16.b Frames

The import and export filter will support the new anchor and alignment settings for
frames of MS Word 2000. The different settings will cover horizontal alignment, vertical
alignment and anchor definitions of frames.

2.2.16.c Negative Indents

Negative indents for paragraphs and tables will also be supported by the import and ex-
port filter.

2.2.16.d Asian Typography

The feature “Double Line in one line” will be importable from and exportable to MS Word.

2.2.16.e Character Embossed and Engraved

The features “Character Embossed” and “Character Engraved” will be supported by the im-
port and export filter.

2.2.16.f Underlining and Strikethrough Color

Colors for underlining and strikethrough differing from the font color will be supported by
the import and export filter.

2.2.16.g Enabling Paragraph Summation 

The feature “Enabling Paragraph Summation” will boost the compatibility of PowerPoint
paragraphs by adjusting the summation of the lower and upper paragraph spacing accord-
ingly.

2.2.16.h Flyframes inside Frames

Flyframes inside other ones, e.g. insert graphic and insert caption do not retain layout
when exported to MS applications. 
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To remedy this, the parent frame will be exported as a table. This will also provide a work
around for the insert caption feature and illustration index. A floating graphic and its cap-
tion will not be included in a caption index (this is a known flaw in MS Word). Exporting
the floating frame as a table will cause the illustration index in MS Word to be able to rec-
ognize the caption.

2.2.16.i Compatible Tab Stop Behavior

When choosing centered or right alignment, the whole line (including tab stops) will be
moved to the center or right, ignoring any default or manually defined tab positions. One
will be able to switch between old tab stop behavior and the compatible behavior from the
“Tools - Options - Text Document - General – Compatibility” tab page.
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CHAPTER  3 

3 Spreadsheets

3.1 Highlights

3.1.1 New Functions

3.1.1.a ROMAN

A value between 0 and 3999 will be able to be converted to a Roman style by using the
function =ROMAN(value; mode). Mode will be an optional parameter to specify the accu-
racy of the Roman value. Some examples:

ROMAN(999; 0) and ROMAN(999) return CMXCIX
ROMAN(999; 1) will return LMVLIV
ROMAN(999; 2) will return XMIX
ROMAN(999; 3) will return VMIV
ROMAN(999; 4) will return IM

3.1.1.b ARABIC

To convert Roman numerals into a Arabic numbers (between 0 and 3999) the new function
=ARABIC(text) will be able to be used. 

3.1.1.c MIRR

The function MIRR will calculate the modified internal rate of return for a series of cash
flows with interest rates for investments and reinvestments. The function format will be
=MIRR(values; rate_investment; rate_reinvestment).

3.1.1.d CELL

If information about content, formatting, or location of a specific cell is needed, the func-
tion CELL will be able to be used: =CELL(info_type; reference). The type of information that
should be returned will be specified with the first parameter, the second will be optional
and will determine the cell or cell range to be examined.

3.1.1.e ISPMT

The new function ISPMT will calculate the interest of a credit or investment with constant
redemption rates: =ISPMT(rate; amortization_periods; total_periods; investment).

3.1.2 Analysis Addin

This will provide an equivalent to the Excel Addin 'Analysis' to improve the compatibility
descriptions of the functions. 

New formulas in detail will be:

3.1.2.a ACCRINT

Will return the accrued interest for a security paying periodic interest.
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3.1.2.b ACCRINTM

Will return the accrued interest for a security paying interest at maturity.

3.1.2.c AMORDEGRC

Will return the prorated linear depreciation of an asset for each accounting period.

3.1.2.d AMORLINC

Will return the prorated linear depreciation of an asset for each accounting period.

3.1.2.e BESSELI

Will return the modified Bessel function In(x).

3.1.2.f BESSELJ

Will return the Bessel function Jn(x).

3.1.2.g BESSELK

Will return the Bessel function Kn(x).

3.1.2.h BESSELY

Will return the Bessel function Yn(x).

3.1.2.i BIN2DEC

Will convert a binary number to decimal.

3.1.2.j BIN2HEX

Will convert a binary number to hexadecimal.

3.1.2.k BIN2OCT

Will convert a binary number to octal.

3.1.2.l COMPLEX

Will convert real and imaginary coefficients into a complex number.

3.1.2.m CONVERT_ADD

Will convert a number from one measurement system to another.

3.1.2.n COUPDAYBS

Will return the number of days from the beginning of the coupon period to the settlement
date.

3.1.2.o COUPDAYS

Will return the number of days in the coupon period that contains the settlement date.

3.1.2.p COUPDAYSNC

Will return the number of days from the settlement date to the next coupon date.

3.1.2.q COUPNCD

Will return the next coupon date after the settlement date.

3.1.2.r COUPNUM

Will return the number of coupons payable between the settlement date and maturity
date.

3.1.2.s COUPPCD

Will return the previous coupon date before the settlement date.
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3.1.2.t CUMIPMT_ADD

Will return the cumulative interest paid between two periods.

3.1.2.u CUMPRINC_ADD

Will return the cumulative principal paid a loan between two periods.

3.1.2.v DEC2BIN

Will convert a decimal number to binary.

3.1.2.w DEC2HEX

Will convert a decimal number to hexadecimal.

3.1.2.x DEC2OCT

Will convert a decimal number to octal.

3.1.2.y DELTA

Will test whether two numbers are equal.

3.1.2.z DISC

Will return the discount rate for a security

3.1.2.aa DOLLARDE

Will convert a dollar amount, expressed as a fraction, into a dollar amount, expressed as a
decimal number

3.1.2.bb DOLLARFR

Will convert a dollar amount, expressed as a decimal number, into a dollar amount, ex-
pressed as a fraction

3.1.2.cc DURATION_ADD

Will return the annual duration of a security with periodic interest payments.

3.1.2.dd EDATE

Will return the serial number of the date that is the indicated number of months before or
after the start date.

3.1.2.ee EFFECT_ADD

Will return the effective annual interest rate.

3.1.2.ff EOMONTH

Will return the serial number of the last day of the month before or after a specified num-
ber of months.

3.1.2.gg ERF

Will return the error function.

3.1.2.hh ERFC

Will return the complementary error function.

3.1.2.ii FACTDOUBLE

Will return the double factorial of a number.

3.1.2.jj FVSCHEDULE

Will return the future value of an initial principal after applying a series of compound in-
terest rates.
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3.1.2.kk GCD_ADD

Will return the greatest common divisor.

3.1.2.ll GESTEP

Will test whether a number is greater than a threshold value.

3.1.2.mm HEX2BIN

Will convert a hexadecimal number to binary.

3.1.2.nn HEX2DEC

Will convert a hexadecimal number to decimal.

3.1.2.oo HEX2OCT

Will convert a hexadecimal number to octal.

3.1.2.pp IMABS

Will return the absolute value (modulus) of a complex number.

3.1.2.qq IMAGINARY

Will return the imaginary coefficient of a complex number.

3.1.2.rr IMARGUMENT

Will return the argument q, an angle expressed in radians.

3.1.2.ss IMCONJUGATE

Will return the complex conjugate of a complex number.

3.1.2.tt IMCOS

Will return the cosine of a complex number.

3.1.2.uu IMDIV

Will return the quotient of two complex numbers.

3.1.2.vv IMEXP

Will return the exponent of a complex number.

3.1.2.ww IMLN

Will return the natural logarithm of a complex number.

3.1.2.xx IMLOG10

Will return the base-10 logarithm of a complex number.

3.1.2.yy IMLOG2

Will return the base-2 logarithm of a complex number.

3.1.2.zz IMPOWER

Will return a complex number raised by a real number.

3.1.2.aaa IMPRODUCT

Will return the product of complex numbers

3.1.2.bbb IMREAL

Will return the real coefficient of a complex number.

3.1.2.ccc IMSIN

Will return the sine of a complex number.
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3.1.2.ddd IMSQRT

Will return the square root of a complex number.

3.1.2.eee IMSUB

Will return the difference of two complex numbers.

3.1.2.fff IMSUM

Will return the sum of complex numbers.

3.1.2.ggg INTRATE

Will return the interest rate for a fully invested security.

3.1.2.hhh ISEVEN_ADD

Will return true if the number is even.

3.1.2.iii ISODD_ADD

Will return true if the number is odd.

3.1.2.jjj LCM_ADD

Will return the least common multiple.

3.1.2.kkk MDURATION

Returns the Macauley modified duration for a security with an assumed par.

3.1.2.lll MROUND

Will return a number rounded to the desired multiple.

3.1.2.mmm MULTINOMIAL

Will return the multi-nominal of a set of numbers.

3.1.2.nnn NETWORKDAYS

Will return the number of whole workdays between two dates.

3.1.2.ooo NOMINAL_ADD

Will return the annual nominal interest rate

3.1.2.ppp OCT2BIN

Will convert an octal number to binary.

3.1.2.qqq OCT2DEC

Will convert an octal number to decimal.

3.1.2.rrr OCT2HEX

Will convert an octal number to hexadecimal.

3.1.2.sss ODDFPRICE

Will return the price of $100 face value of a security with an odd last period.

3.1.2.ttt ODDFYIELD

Will return the yield of a security with an odd first period.

3.1.2.uuu ODDLPRICE

Will return the price of $100 face value of a security with an odd last period.

3.1.2.vvv ODDLYIELD

Will return the yield of a security with an odd first period.
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3.1.2.www PRICE

Will return the price per $100 face value of a security that pays periodic interest.

3.1.2.xxx PRICEDISC

Will return the price per $100 face value of a discounted security.

3.1.2.yyy PRICEMAT

Will return the price per $100 face value of a security that pays interest at maturity.

3.1.2.zzz QUOTIENT

Will return the integer portion of a division.

3.1.2.aaaa RANDBETWEEN

Will return a random integer number between the numbers you specify.

3.1.2.bbbb RECEIVED

Will return the prorated linear depreciation of an asset for each accounting period.

3.1.2.cccc SERIESSUM

Will return the sum of a power series based on the formula.

3.1.2.dddd SQRTPI

Will return the square root of ( number * pi ).

3.1.2.eeee TBILLEQ

Will return the bond-equivalent yield for a treasury bill.

3.1.2.ffff TBILLPRICE

Will return the price of $100 face value for a treasury bill.

3.1.2.gggg TBILLYIELD

Will return the yield for a treasury bill.

3.1.2.hhhh WEEKNUM_ADD

Will return the week number in year.

3.1.2.iiii WORKDAY

Will return the serial number of the date before or after a specified number of workdays.

3.1.2.jjjj XIRR

Will return the yield for a treasury bill

3.1.2.kkkk XNPV

Will return the net present value for a schedule of cash flows.

3.1.2.llll YEARFRAC

Will return the year fraction representing the number of whole days between start_date
and end_date.

3.1.2.mmmm YIELD

Will return the yield on a security that pays periodic interest.

3.1.2.nnnn YIELDDISC

Will return the annual yield for a discounted security (e.g. treasury bill).
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3.1.2.oooo YIELDMAT

Will return the annual yield of a security that pays interest at maturity.

3.1.3 New WebQueries Dialog

Data from external sources (aka linked areas or WebQueries) will be able to be inserted by
selecting "External Data Source" from the "Insert" menu in addition to the alternative way
of using the Navigator. 

The dialog will call for the selection of a file (by entering an URL or using the file dialog),
and selection of one or more named ranges within the specified file. If the source is an
HTML file loaded with the new WebQuery HTML filter, the names represent the tables in
the HTML file. In addition, an interval for automatic refresh of the link will be able to be
specified.

To change the settings for a linked area, the "Modify" button of the "Edit Links" dialog will
be used.

3.1.4 New Printing Options

The print dialog for spreadsheet documents will have an "Options" button, similar to that
found in Writer.

There will be two options:

� Suppress output of empty pages:
If this option is active, pages that do not contain cell contents or drawing objects will
not be printed. Furthermore page numbers will be ignored. Cell attributes (such as bor-
ders or background color) are an exception to this rule and will not count as content.

� Print only selected sheets:
If this option is active, choosing "All" in the print dialog will print only the selected
sheets. Similarly, only a specified range of pages will be counted within the selected
sheets. 

The options dialog (Tools/Options) has a new page "Print" in the Spreadsheet section,
where the defaults for these two print options will be able to be set.

3.2 Other Noteworthy Enhancements

3.2.1 Password Protection of Change Track Function

The status switch for Change Track function will be able to be protected with a password.
Thus change tracking on sensitive data/spreadsheets will be able to be locked in the 'on'
position.

3.2.2 Enlarged Matrix Arrays

The number of elements, that will be able to be used in a matrix array, has been increased.
In former versions this number was limited to 16384 elements per matrix, the new limit is
512k elements. This is particularly useful for scientific calculations.

3.2.3 Enlarged String Length

The maximum string length for formulas has been increased from 255 bytes to 64kB. This
will be particularly useful for concatenating strings where the sum of all lengths is greater
than 255 characters. However, a literal string entered directly as a formula (="hello world")
will still be limited to 255 characters (including the quotes).

Positive side effects of this change will be faster calculation and a smaller memory foot-
print, especially for strings. This is due, in part, to the fact that single cell references will be
redesigned to require 14 fewer bytes of memory than previously.
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3.2.4 Advanced Multiple Operation

The Multiple Operation has been extended to formulas containing references to other for-
mulas. Thus a multiple operation (available under the Data menu > Multiple Operations)
is no longer restricted to acting only upon the formula selected in the dialog. Instead, cell
addresses that are indirectly referred to will be replaced in every formula encountered dur-
ing a Multiple Operation calculation.

3.2.5 Improved Change Tracking for Matrices

Change tracking for matrices will be improved: Rejecting (or accepting if there were any
subsequent content changes) an insertion of a matrix formula will be possible.

3.2.6 Improved ASCII Import

When importing a text file into a spreadsheet, English date formats will be recognized in
addition to those of the system language, even when they contain English month names.
This will allow for the importation of formats like 12-Mar-01 correctly, independent of the
system language.

3.2.7 Advanced Text Filter

16-bit Unicode text files will be able to be imported and exported by using the text filter
"Text – txt – csv."

3.2.8 Additional Settings on Paste Button

The Paste button within the function bar will include a contextual menu, activated by a
long single mouse click. 

This new menu will enable the user to choose between additional paste formats such as
Unformatted Text, Bitmap, etc. The dialog will contain the same selection that is available
through “Edit – Paste Special.”

3.2.9 Additional Settings on Undo and Redo Buttons

The Redo and Undo buttons within the function bar will include contextual menus, acti-
vated by a long single mouse click.

The new menus will enable the user to undo and redo the last action.  Additionally, users
will be able to choose from a list of undo and redo steps that are available.

3.2.10 Use of Printer Metrics for Text Formatting

A new option will be introduced on the general spreadsheet options page. It will switch the
use of printer metrics for text formatting of cells on the screen (WYSIWYG). The option will
be a global setting and will not be saved with individual documents.  

3.2.11 Automatic Hyphenation within Cells

Automatic hyphenation will be available for text in cells and drawing objects in a spread-
sheet.

The "Alignment" page of the cell attributes will have a new checkbox to activate hyphen-
ation. It will be enabled only if line breaks or block alignment is selected.

3.2.12 New API Services and Interfaces

Along with the completely new design of the OpenOffice.org API are some new features
that will be available for spreadsheets. These are introduced here, in brief. For further de-
tails please see the API project and its documentation.
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3.2.12.a Service for Function Access

A new service (com.sun.star.sheet.FunctionAccess) will be implemented which will allow ex-
ternal programs to call OpenOffice.org's spreadsheet functions to obtain the results. 

3.2.12.b Interface for Cell Ranges

A new interface (com.sun.star.sheet.XCellRangeData) will allow users to read and write data
(text or numbers) from a cell range with one single call.

3.2.12.c Interface for Range Selection on the View

A new interface for the view (com.sun.star.sheet.XRangeSelection) will allow the selection
of cell ranges from a dialog.

3.2.13 Advanced MS Office Filter

3.2.13.a Highly Improved Import and Export of MS Excel Charts

Many more chart properties will be supported by the MS Office filter when importing/ex-
porting spreadsheets from MS Excel. These will include:

� Content of charts (properties of series, title, primary and secondary axes, gridlines, leg-
end, data labels, and format as well as properties of different chart types)

� Format of 2-D and 3-D charts (properties of mode, custom style, custom color, custom
weight, column shape and data of different chart elements)

� Settings for X-, Y-, and Z-axes and gridlines

3.2.13.b Sheet and Document Settings

The following settings will be importable and exportable to MS applications:

� Number of the visible sheet

� Grid on/off

� Grid color

� Show formulas on/off

� Show column & row headings on/off

� Show zero values on/off

� Show outline symbols on/off

� Sheet selected/not selected

� First visible column/row

� Horizontal/vertical position of a window split

� Horizontal/vertical position of frozen panes

� First visible column/row in the splits

� Cursor position

3.2.13.c Further Improvements

Further improvements to the import/export filter for MS Excel 97/2000 will be made to
the following features:

� Pivot tables (export)

� AutoFilters and Advanced Filters (import/export)

� scenarios (export)

� references to external tables or table ranges (export)

� merged cells (export)
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� groups (import/export)

� print ranges and titles (export)

� styles (import/export)

� recorded changes (import/export)

� hyperlinks (import/export)

� page breaks (export)

� several spreadsheets functions (export)

� cell text rotation (import/export)

� invisible flags (export)

� cell protection flags (export)

� matrix formulas (export)

� shared formulas (export)

� background graphics (export)

� multiple operations (import/export)
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CHAPTER  4 

4 Presentations and Drawings

4.1 Highlights

4.1.1 Improved Performance

An optimized implementation for drawing object attributes will result in a significant in-
crease in performance, especially when interacting in groups or object-filled pages (large
selections).

4.2 Other Noteworthy Enhancements

4.2.1 Cropping for Pixel Graphic

The Graphics Object bar will contain a new control to set the cropping of a selected pixel
graphic.

4.2.2 Additional Settings on Paste Button

The Paste button within the function bar will include a contextual menu, activated by a
long single mouse click. 

This new menu will enable the user to choose between additional paste formats such as
Unformatted Text, Bitmap, etc. The dialog will contain the same selection that is available
through “Edit – Paste Special.”

4.2.3 Additional Setting on Undo and Redo Buttons

The Redo and Undo buttons within the function bar will include contextual menus, acti-
vated by a long single mouse click.

The new menus will enable the user to undo and redo the last action.  Additionally, users
will be able to choose from a list of undo and redo steps that are available.

1. Improved Import of MS PowerPoint Presentations

When importing presentations from MS PowerPoint, the document will display using the
last view (Slide, Outline, Notes, Handout or Master view). Previously, MS PowerPoint docu-
ments loaded always displaying in Slide View.

Furthermore, compatibility with MS PowerPoint will be improved on imported paragraphs.
The import filter will account for the difference in the space calculation between para-
graphs in OpenOffice.org and MS PowerPoint

4.2.5 Improved Export of Hatches

Drawing objects with a hatching will be able to be exported into MS Word, Excel or Power-
Point. The export filter will convert the vector oriented hatches (not supported by MS Of-
fice) into bitmaps.
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4.2.6 Command Line Options for  Impress Player 

The following command line options for the Impress Player will be implemented:

� [A|a]:
Enable/disable automatic slide transition

� [L|l]:
Enable/disable presentation looping

� [F|f]:
Enable/disable full screen presentation window

� K:
Enable kiosk mode, which will include -A, -L and -F, as well as forcing the presentation
window into the foreground.

4.2.7 Cache Buffering Setting for Graphics

It will be possible to set an upper limit (in KB) for the graphics cache (Total cache size) as
well as an upper limit for one single graphic object to be cached. If the size of one object
exceeds this predefined size, the graphics output will not be cached, which means, that the
graphic will be directly rendered on the screen every time a paint request occurs.

4.2.8 Extended UI for Printing Options

Printing graphics containing transparencies will have additional print options:

� Reduced Transparency
This will allow the user to treat all transparent objects as non-transparent. Additionally,
the option  'Automatic' will reduce the transparency only if the covered area of replace-
ment is more than 1/4 of the whole page. The option 'No transparency' will always re-
duce transparency completely.

� Reduced gradients
The number of gradient steps will be decreased to the real number set when the gradi-
ent was defined.

� Reduced bitmaps
Choosing to print/render bitmaps at maximum resolution (in dpi) will result in all
transparencies being printed as well.

� Convert colors to grayscale
If this box is checked, output will be rendered in grayscale.

4.2.9 All MS PowerPoint AutoShapes will be importable

All available AutoShapes from within MS Office will be importable and exportable.

4.2.10 Enhanced EPS export filter

The eps export filter will provide text export as glyph outlines. This setting will be the de-
fault. Thus it will be possible to export text containing CJK fonts (or other double byte
characters).

4.2.11 New Impress AutoLayouts for Vertical Text (CJK)

Four new AutoLayouts containing vertical text will be introduced to presentations.
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CHAPTER  5 

5 Database Access

5.1 Highlights

5.1.1 New Database Source Concept

Instead of creating and maintaining a proprietary database format (aka StarDataBase .sdb),
OpenOffice.org will work with external data sources. 

OpenOffice.org will be able to connect and administer a wide variety of data sources and
provide data access to all OpenOffice.org components.

5.1.2 New Data Source Administration Dialog

A new menu item "Tools – Data sources" will be available making it possible to administer
office-wide registered data sources within a new dialog. Here the user will be able to con-
nect to data sources and/or access registered ones. All connected data sources will be dis-
played in a list box and, for each entry, the properties of the connection will be specified.

The dialog will be similar to the Properties dialog of a database from StarOffice 5.2. How-
ever, it will contain a new page, 'Queries' from which it will be possible to open the query
design to define new queries or edit existing ones.

Specifying a data source will become easier, as protocol schemes for defining the data
source URL (e.g. "sdbc:dbase:" for the dBase format) which are necessary to determine
which database driver should be used to build the connection, will be hard-coded in the
edit field. If the user selects a data source type, the corresponding protocol scheme  will be
entered by the program automatically in the URL edit field.

In addition, above the tree list within the table view there will be a toolbox with the fol-
lowing items:

� New table
Opens the table desgin, creating a new table for the data  source

� Edit table
Opens the currently selected table for changing its design, i.e. changing the table struc-
ture (available only if exactly one table is selected).

� Drop table
Drops the currently selected tables.  Available if all selected entries in the list are tables
(i.e. no catalogs, no schemas, nothing in the "all tables" root entry).

5.1.3 New Data Source Browser

The data view of the current database, accessible via View - Current Database or F4, will be
extended to include a tree view displaying the available tables and queries of the con-
nected data sources. The user will be able to switch between the different data sources by
simply selecting an entry. When switching to another table, the data will be loaded in the
table grid. This way the user will be able to interactively browse any tables of an arbitrary
registered data source.

35



The context menu of the table view will offer some commands which will depend on the
current selection, for example for editing, copying, deleting database objects or creating
new tables or queries in the design mode. The tree view will be able to be faded in and out
by pressing a button in the toolbox of the data source browser. Extentions of this will in-
clude icons for

� switching to edit mode

� saving the current record

� undoing the current record's changes

� cut/copy/paste

5.1.4 New Database Driver

A new database driver will support access to the operating system's address book, as can be
found in MS Outlook Express, MS Outlook, Mozilla and LDAP compatible address books. 

The driver will be called “Addressbook“. The browse button will allow the user to select be-
tween different address books (if applicable). If an LDAP address book is chosen, a new de-
tailed page will be available for specific data insertaion such as password check (if re-
quired) and more.

5.1.5 Spreadsheets as Data Sources

In the Data Source Administration dialog it will also be possible to specify a spreadsheet
document as data source type. If "spreadsheet" is selected in the dialog, a spreadsheet file
will be able to be chosen as data source.  This will work not only for OpenOffice.org spread-
sheets but MS Excel spreadsheets as well. Each (non-empty and non-hidden) sheet with col-
umn headers will be used as database table. The access will be read-only.

It will also be possible to use a database range within a spreadsheet document as a data-
base table. Database ranges must not contain column headers. They will be generated auto-
matically, if necessary. 

5.2 Other Noteworthy Enhancements

5.2.1 AutoPilot for Importing Databases

An AutoPilot for importing *.sdb-files from StarOffice 5.2 or previous versions will be avail-
able under File - AutoPilot - StarOffice 5.2 Database Import. Since the method for accessing
data sources has been changed radically, this migration path is provided.

5.2.1.a New model of accessing data

Queries, forms and reports, that have been created with StarOffice used to be saved in
*.sdb-files. Data access information will not be stored in these files anymore. Instead, the
information about the data sources will be stored in the configuration (DataAccess.xml),
which is also valid for queries. Form documents will not be stored in a *.sdb-file anymore.
They will be handled just as normal documents, stored in the file system.

5.2.1.b Features of the AutoPilot

The AutoPilot accounts for the differences mentioned above. It will allow the user to:

� select an sdb file

� create a new data source with the settings extracted from the file, so that applications
can access the data

� extract the queries from the file and store them in the configuration, either in the data
source being created or in another one

� extract all form documents from the database storage file and save them to a directory
of the user's choice.  All form documents will be saved as Writer documents that con-
tain the necessary data fields to connect to the original database
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� the to-be-imported database access refers to a dBase or text-base database the path to
the data contains one of the variables

� $(USER)

� $(USERURL)

� $(INST)

� $(INSTURL)

Note: Reports will be not extracted.

5.2.2 Advanced Table Subscription

When subscribing database tables in the Data Source Administration dialog, the user will
be able to choose, whether only specific tables should be subscribed or whole containers. If
a container is subscribed, all of the database tables that will be created later, will be avail-
able automatically when reconnecting to the data source.

A container will be just the "All tables" root entry or, if the data source supports this, an en-
try representing a catalog/schema. Subscribing will be done by simply clicking on the cor-
responding check box of the table or container entry, respectively. To see the difference dis-
played, containers which are checked as such (and not because all of their children are
checked) will be displayed bold.

5.2.2.a Displaying Version Columns

A new check box on the tables subscription page will control whether a version of data rec-
ords should be displayed. This will be able to be used for databases that support version
fields. Those fields change their values, if a data record is changed.

5.2.3 Advanced Query Design

In query design mode, new buttons will be available in the Object bar: Save, Save as, Undo
and Redo.

5.2.4 Improved AutoPilot for Combo and List Boxes

A new page will be added to the AutoPilot for combo/list boxes. Because forms will no
longer be bound to a data source, this page will allow the user to assign a database when
inserting a control. 

5.2.5 Automatic Control Focus

A new Auto Focus mechanism will be available for form layers of documents. An icon will
be offered which will allow the user to set the focus automatically within controls. It will
be found in the Form toolbar and will be called "Automatic control focus." It will be used
when switching from Design mode to Alive mode.

If the automatic control focus is active, the first control of the first logical form of the
document will receive the focus. This will be useful for forms created in an OpenOffice.org
document, e.g. a text document, which is used only for data entry.

5.2.6 New Form Events

Two new events will be offered in the form property browser to bind macros:

� before reloading: called before a reload on the form is executed

� unloading: called before the form is unloaded.

Previously, these events could be used only with a scripting language.
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5.2.7 New Index Design for Tables

A new index design for tables will be available. This component will be completely rewrit-
ten. A new slot in the toolbox of the table design opens a dialog (instead of the former ex-
tra view) which will be able to be used to edit the indexes of the table.

5.2.8 Enhanced Drag and Drop

In the explorer pane of the data source browser, the user will be able to copy tables and
queries between data sources using drag and drop or clipboard. This action will be achieve-
able by dragging or copying an object, table or query, onto/into the object container of a
data source.

In addition to copying an object into an container of the same type, the user will also be
able to copy a query as a table. In this case, a new table will be created and filled with the
data from the query.

Furthermore, RTF and an HTML based tables and queries will be able to be dropped into a
text document. The result will be a formatted version of the table's data.  This will also
work from table to RTF or HTML.

5.2.9 Japanese Search Settings Available Within Database

The user interface for searching database forms and tables/queries will be extended to in-
clude capabilities for Japanese search.

This includes an additional check box for "Match half/full width forms" and a "Sounds like
(Japanese)" option.

Both options will be exactly the same as e.g. in the word processor's text search dialog.

5.2.10 Use of Catalog in ODBC File Based Drivers

It will be possible to avoid using catalogs in file based ODBC data sources.  The check box
for this will be located on the ODBC page in the data sources dialog.  Not using a catalog
with file based databases will be the default.

5.2.11 Menus in Design Components

Menus will be available in the table-, query-, relation design components. The menus will
contain basic settings such as Undo and Redo, Cut, Copy and Paste as well as Close, Quit
and New. 

5.2.12 Documents Associated With Databases

On the subject of data forms, OpenOffice.org will offer a list of bookmarks administrable
through the “Tools - Data Sources” dialog for every data source. 

These bookmarks will simply consist of a name and an URL pointing to a document. Thus
forms will be easily createable and maintainable. Furthermore, using this method, ordinary
text documents will also be able to be associated with databases.

5.2.13 UTF-8 Available in the Data Source Administration Dialog

UTF-8 will be available as a new character set in the Data Source Administration dialog.

This will not apply for:

� ADO data sources
(Which do not have a character set selection at all)

� dBase data sources.
(dBase files saved with UTF-8 encoding would not comply to the dBase standard, thus
no external program would be able to read them correctly)
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CHAPTER  6 

6 New Programming Interface (API)

6.1 Highlights

6.1.1 Full C++ and Java Support

The new OpenOffice.org API will fully support C++ and the Java programming language,
thus covering the two most commonly used programming languages.

6.1.2 Language Independent API

Apart from the "out-of-the-box" support of C, C++ and Java, nearly all other programming
languages (including Scripting Languages) will be able to be linked to the OpenOffice.org
API. This will be achieveable by writing individual language bindings.

Thus, there will be no limit for office automation in heterogeneous environments.

6.1.3 Component Orientation

While the old API was Object Oriented the new API is fully Component Oriented. This al-
lows the programmer not only to make use of OpenOffice.org objects but also to use three
types of OpenOffice.org components:

� Exchange/Extend OpenOffice.org components with your own (where applicable)

� Isolate components and (re-)use them in another application (e.g. using Chart function-
ality within money calculation software)

� Embed OpenOffice.org: OpenOffice.org will be able to be fully embedded into existing
workflow environments.

6.2 Other Noteworthy Enhancements

6.2.1 API is Content Oriented

The new OpenOffice.org API will use content rather than UI for automatization. This will
allow the programmer the ability to program processes that are not in focus and to access
functions that are not available through OpenOffice.org's UI.

6.2.2 More Power

The new API incorporates many more features than the old one placing much more power
in the hands of developers.

E.g. the integration of the up and coming East-Asian word processor import and export fil-
ters will be entirely realized through the new API.
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6.2.3 Exchanging UI

With the new API it will be possible to exchange the complete OpenOffice.org UI with an-
other one. This will give developers the ability to create their own UI, e.g. simplified UI for
children.

6.2.4 Office Development Kit (ODK)

The ODK (http://udk.openoffice.org/udk_package.html) will contain all needed libraries,
JAR-Files, etc. to access OpenOffice.org and to write components as well provide developers
the ability to use it as a development base.

The ODK sources are readily available on OpenOffice.org (http://www.OpenOffice.org) and
are easy to build.

6.2.5 Reorganization of BASIC Modules

All BASIC Modules will be reorganized and saved in the new XML based format.

6.2.6 Enhanced Dialog Editor (IDE)

The dialog editor will be rewritten and extended in functionality.
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